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WORD  i  EXCEL - MOŽDA NISTE ZNALI 
 

PRIPREMA "PRAZNOG" PREDLOŠKA-DOKUMENTA (TEMPLATE) 
(ELEKTRONSKI FORMULAR) 

 
Dosadilo Vam je uvijek iznova pisati zaglavlje Vašeg memoranduma ili raznih obrazaca ? Zato  

uzimate zadnji dokument i prepravljate upise kako biste kreirali novi. No WORD i EXCEL nude bolje  
rješenje. To su tzv. predlošci (Template) koje možemo koristiti i za "elektronske formulare".   

Jednostavno kreirajte "prazan" dokument, esto korištenu tabelu ili memorandum. U inite to malo  
pažljivije i lijepo ga dotjerajte. Zaglavlje možete upisati u nekoliko tekstnih okvira (Textbox)        iz  
grafi kog niza naredbi         uz proizvoljno oblikovanje tekstova u njima. Tekstne okvire s tekstom  
možete precizno pozicionirati mišem. Odabirom prozirnog okvira i prozirne pozadine - No Fill i No  
Border ( Bez ispune i Bez okvira) tekst e djelovati kao da je na staklu, tj. tekstove možete proizvoljno  
me usobno približiti ili pisati preko slike. Za kratke tekstove poput naziva tvrtke možete koristiti i  
umjetni ke tekstove (WordArt) koji se mogu razli ito efektno, pa i trodimenzionalno oblikovati.  
Kada ukopirate logotip ili neku sli icu na dokument, postavite ga  iza teksta, ako je želite proizvoljno  
premještati mišem. Postavite kursor (tj. kliknite) iznad slike i stisnite tipku ENTER. Iznad kursora otvara se 
novi redak, tj. ostatak teksta skupa sa slikom premjestit e se prema dolje. Da sprije ite daljnje  
samovoljno premještanje logotipa ili zaglavlja smještenog u tekstne okvire (textbox), jednostavno  
ozna ite sve sadržaje koji ine zaglavlje (jedan ili više tekstnih okvira i logotip) i grupirajte ih grafi kom  
opcijom Crtaj > Grupa, a zatim itavu grupu premjestite prema vrhu stranice iznad kursora. Nakon  
toga, zaglavlje se više ne e premještati prilikom nastavka pisanja teksta, odnosno otvaranja novih redaka.  
  

ito zbog programske greške u Wordu zna se dogoditi da se tekst nekog od tekstnih okvira ne ispiše na  
papiru, iako se uredno prikazuje na ekranu u Print Preview - u. To se me utim doga a samo ako koristite 
pretpostavljenu bijelu pozadinu u tekstnim okvirima. To je razlog više da za pozadinu tekstnih okvira 
odaberete prozirnu pozadinu (No Fill, odnosno "Bez ispune"). U tom slu aju izbje i ete gubitak teksta na 
ispisu. Ne zaboravite da ne možete editirati tekst dok je aktivna strelica za grupiranje.  
  
Kliknite na prazna mjesta budu eg teksta (npr. koja smo definirali tabulatororm ili tabli nim elijama) i  
definirajte vrstu i veli inu slova, te po potrebi podebljani ispis. Sve što definirate u uzorku, (adresni  
prostor, "Predmet:", "Poštovani ", potpis i dr.) ne ete morati sto puta definirati u svakom pismu. 
   

Tako pripremljen dokument trebamo pospremiti kao predložak (Template) naredbama  
File > Save as (Datoteka > Spremi kao)  i tom prilikom mjesto vrste dokumenta .DOC   u WORD-u  
biramo .DOT, a u EXCEL-u mjesto  .XLS biramo .XLT.  Ove vrste dokumenata navedene su pod opcijom  
Document Template (predložak dokumenta) u eliji ispod elije za unos imena budu eg dokumenta.    
  

Predložak ne smijemo ispunjavati, nego ga uklanjamo sa ekrana nakon spremanja.   
Pri svakoj novoj uporabi Predložak otvaramo opcijama  File > New (Datoteka > Nova)  i biramo ciljani   
*.DOT ili XLT uzorak sa liste predložaka koja se automatski otvorila. Ispunjavamo dokument i normalno  
spremamo s proizvoljnim imenom na proizvoljnu lokaciju kao DOC ili XLS dokument, a predložak ostaje  
nedirnut za slijede u uporabu. U cilju prepravka predložak moramo otvoriti za to namijenjenom opcijom.  
           Na kraju, mogu e je kombinirati skenirani formular koga smo s copy-paste ukopirali na prazan  
WORD-ov list. Opcijom omatanja teksta iz WORD-ovog menua za editiranje slika, prvo formular  
postavimo iza teksta, što nam daje mogu nost da ga premještamo i dimenzioniramo po volji, a zatim  
pozicije i izgled upisa definiramo tabulatorom i uobi ajenim opcijama za ure ivanje teksta. Proizvoljno  
premještanje slike mišem po papiru tako er je najlakše posti i postavom slike iza teksta.   

 
esta greška u predlošcima  

  
Manje verzirani korisnici Worda ( esto je rije  i o službenim "elektronskim formularima" raznih uprava, pa i 
državnih institucija), prostor za unos podatka kreiraju na slijede i pogrešan na in:  
  
Prezime i ime : ________________________  
  
Ovo je potpuno krivo, jer upis na mjestu podvlake gura crtu podvlake u desno i pokvarit e obrazac  
prilikom ispunjavanja. Stoga se to radi ovako (u praznom retku ispod utipkavaju se znaci  -----------) :  
  
Prezime i ime:   (tabulatorom ujedno definirajte po etak teksta)   
 ---------------------------------- 
Ako dvoto ku podebljate to se ne e primijetiti, a naknadno upisan podatak e biti naglašen, tj. masno 
pisan. Umjesto toga, može se dakako kreirati tabela i prostor za upis predvidjeti u praznim elijama tabele. 
Pri kreiranju tabela obavezno koristite pogled "izgled ispisa" da Vam ne bi pola obrasca falilo na stranici. 
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O EXCEL - TABELAMA 
 

Ve  i uporaba samih formula u tabelama EXCEL-a  predstavlja svojevrsnu automatizaciju, 
budu i da se svi me urezultati i rezultati automatski rekalkuliraju kad god se unese bilo koja 
vrijednost u Excel. To nam daje mogu nost da praznim elijama za ulazne podatke, i upisom 
svih formula u tabeli pripravimo "praznu" tabelu – odnosno predložak, u kome emo gotove 
rezultate dobiti svaki puta kada u podru je ulaznih podataka unesemo nove podatke.  

Ako je rije  o tehni kim prora unima, u Excel emo bez problema ukopirati skice, slike  ili 
crteže potrebne uz prora un obi nim copy – paste postupkom. 

 
Pri kreiranju formula, uvijek privremeno unesite testne podatke s okruglim brojevima, 

kako bi provjerili da formule dobro funkcioniraju. Te pokusne podatke emo prije spremanja 
uzorka izbrisati.  Korisno je elije ulaznih podataka obojiti nekom pastelnom nijansom. elije u 
kojima su formule treba zaštititi od izmjena, na na in da se itav radni list (worksheet), a 
eventualno i radna knjiga  (workbook)  zaštiti menu-opcijama: 

 
Tools > protection > Protect sheet  tj:  Alati > zaštiti dokument > zaštiti list. 
 
Slijedi panel u kome treba unijeti lozinku kojom se po potrebi zaštita može ukloniti. 

Lozinku treba ponoviti još jednom, zbog sprje avanja greške u tipkanju. Lozinku je dobro 
negdje zapisati, jer je za šest mjeseci više ne ete znati.  Mogu a je i zaštita bez korištenja 
lozinke (u tom slu aju svatko može otkriti i pokvariti sve formule koje ste zaštitom sakrili). 

Inicijalno e sve elije biti zašti ene od izmjena, što bi onemogu ilo i unos podataka. Zbog 
toga podru je (i-ili pojedina ne elije) ulaznih podataka treba prethodno isklju iti iz zaštite, tj. 
dozvoliti izmjene u njima, tako što se takve elije ozna e kursorom, i primijeni niz naredbi  

 
Format > Cells > Protection Klikom skinuti kva icu u eliji  Locked (zaklju ano), 
(Oblikovanje > elije > zaštita)        ime se elija ili skup elija "otklju ava" 
 
Prije zašti ivanja lista ili knjige  (sheet  ili  Workbook)  mogu se ukloniti križaljka 

(gridlines) i slovno-broj ana mreža zaglavlja  (Row and colum headers), kao i traka za 
prikaz formula  (Formula bar) pri vrhu EXCEL-ovog okvira, tako da se pred krajnjim korisnikom 
sakriju i formule pomo u kojih se obavljaju izra unavanja. No, sadržaj elija koje nisu zašti ene, 
može se prikazati, pa i izmijeniti dvoklikom na eliju i kad je traka za formule isklju ena, ali 
samo ako je skinuta kva ica hidden (sakrito)  na spomenutom dijaloškom okviru. U protivnom, 
dvoklik briše sadržaj nezašti ene eije, tj. u sakritoj nezaštienoj eliji nije omogu eno 
ispravljanje sadržaja elije, nego samo zamjena novim sadržajem. 

Po potrebi, mogu se iz tabele ukloniti i nule koje su rezultat formula kada nema ulaznih 
vrijednosti  (Zero value). Sve se to obavlja u panelu koji otvaramo opcijama  Tools > Options 
(Alati > Mogu nosti) 

Ponekad se javlja greška (#DIV0!) na mjestu formula, posebno ako je u nazivniku adresa 
prazne elije u kojoj još nema ulaznog podatka. Da se izbjegne oznaka greške u takvim 
slu ajevima, može na nazivnik dodati vrlo mala vrijednost, koja ne e zna ajno izmijeniti 
rezultat, npr:  2/(A11*$K$3+0.000001) 

Vrjednost 0,000001  služi za sprje avanje greške dijeljenja s nulom. Obratite pažnju, da 
ona mora biti dodana nazivniku (tj. u i unutar zagrade) a ne itavom izrazu.  Naravno, takvo 
rješenje ne smije se primijeniti u rijetkim prilikama kad je neophodna maksimalna preciznost 
rezultata na veliki broj decimala. 

 
EXCEL  omogu uje i izradu obrazaca sa ugra enim izbornim opcijama s kruži ima      , tzv. 

"radio-gumba" (Option Button) i s kva icama        (checkbox).  Gumbi s kruži ima se uvijek 
koriste u grupi, pri emu je u svakoj grupi mogu  izbor samo jedne od ponu enih opcija. Za 
razliku od toga, svaka kva ica se u pravilu može aktivirati zasebno, tj. može ih se istovremeno 
aktivirati više.  
     Elementi koje moramo podesiti u svojstvima (propertis) opcija sa kruži ima ili kva icama 
su: Caption (to je natpis na dugmetu), kod kruži a i Group name (naziv grupe dugmadi) a u 
excel-u još i: Linked Cell – to je proizvoljna elija koja e pamtiti stanje opcije TRUE ili FALSE 
(uklju eno ili isklju eno) Ostalo je šminka. Detaljnije o radio-gumbima može se na i u:  
ELEMENTARNI VISUAL BASIC – str. 24-25  na našem web-sjedištu www.inovatori.hrvatska.com  

http://www.inovatori.hrvatska.com/
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WORD i EXEL  -  MOŽDA NISTE ZNALI 
WORD i Excel su mo ne aplikacije. Uz nešto vježbe, strpljenja i dovitljivosti, osobito u 

EXCEL-u možete stvoriti i sasvim pristojne aplikacije, koriste i macro-e (makroinstrukcije), 
Combo-Box  (kombinirana izborna elija) iz alatne trake Control-Toolbox,  lookup-funkcije i 
njihovu kombinaciju, te izborne opcije, odnosno obrasce (Forms) s navedenim elementima.   

 
SNIMANJE MAKRO-A 

 
Prvo da znamo: budu i da macro-i mogu skrivati zlo este subrutine, OFFICE se od toga brani 
odabranim nivo-om zaštite koji se bira opcijama Tools > Macro >Macros > Security (Alati > 
makro > makro naredbe > sigurnost). Nude se tri nivoa zaštite. Ako se odabere maksimalna 
sigurnost, OFFICE ne e htjeti ni u itati datoteku koja sadrži macro-e. Preporu amo srednji 
stupanj sigurnosti, pri kome e nas OFFICE upozoriti da datoteka sadrži macro-e i prepustiti 
nam odluku o njihovoj uporabi. Najniži stupanj sigurnosti dopušta korištenje datoteka s macro-
ima bez ograni enja i ne e nas gnjaviti s upozorenjima o sigurnosti.  
Može se dakle dogoditi, da datoteku s makroima koja normalno funkcionira na našem ra unalu, 
ne e mo i normalno koristiti korisnik na drugom ra unalu, ako ima uklju en viši nivo zaštite, 
koga možda i ne zna promijeniti.  
 
Korisniku koji ima instaliran antivirusni program, srednji stupanj OFFICE-ove zaštite bit e 
sasvim dovoljan. Na kraju, OFFICE daje i mogu nost da se definiraju Pouzdani izvori, tj. 
datoteke  u kojima e macro-i biti dopušteni u svim nivoima zaštite. (opcije: Alati > makro > 
makroi > sigurnost > Pouzdani izvori). 

 
Vjerojatno znamo da i u WORD možemo umetnuti EXCEL-ovu tabelu, pa e ona i u WORD-

u podržavati sve EXCEL-ove mogu nosti kada dvokliknemo na tako umetnutu EXCEL tabelu. Klik 
van tabele zatvara EXCEL-ove komande i vra a WORD-ove. Tabelu ume e klik na ikonu       .  

 
Macro (makroinstrukcija) je slijed programskih rutina koje ra unalo automatski izvodi 

onako i onim redosljedom kako ih je korisnik ru no izvodio prilikom snimanja macro-a. Korisnik 
treba uklju iti postupak snimanja, izvesti ru no slijed radnji koje želi automatizirati, te 
imenovati gotov macro. Iza toga dokument naravno treba spremiti da se macro sa uva. 

 
Postupak snimanja makroa 

 
1. Tools > Macro > Record new Macro Otvara se panel za opcije snimanja 
 
2. u eliju macro name utipkaj ime budu eg 

makro-a (Nisu dopušteni razmaci, pa ime 
treba imati jednu rije , ili se rije i imena 
razdvajaju znakom _ )  

 
 
 
 
 
 
 
 
 
3. u eliji Store macro in klikni na trokuti  na desnom kraju elije i odaberi opciju. U pravilu 

makro treba vrijediti samo u failu koga obra ujemo, tj. biraj konkretni fail ili Document 
based on ...dot ) za ugradnju makroa u uzorak na kome se dokument temelji. Nemoj 
ugra ivati makroe u Normal.dot, jer e se u protivnom on ugraditi u sve tvoje budu e 
dokumente, iako ti to možda nije bila namjera.  

 
4. Lijevi klik na sli icu Keyboard otvara se panel za definiranje pre ice 
      (Makro se može ugraditi i u alatnu traku  
 klikom na sli icu Toolbars sa eki em) 

OVO SE ISPISUJE AUTOMATSKI 
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5. U eliji Press New shortcut Key stisni tipku kojom e se makro startati. Program e toj 
tipki dodati prefiks CTRL+  ili ALT+ pa onda treba koristiti kombinaciju tipki za startanje 
makroa. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. U eliji Save changes in:  definiraj kojem failu e makro biti pridružen (spremljen). Ako je 

rije  o uzorku formulara (template), odaberi .dot ili  .xlt  template,  a u slu aju pojedina nog 
dokumenta  odaberi konkretno ime dokumenta 

 
7. klik na Close zatvara panel  Na radnom prostoru prikazat e se 
  dugme stop za prekid snimanja.Istovremeno, 
  uklju ilo se snimanje makroa, pa od ovog  
  trenutka do pritiska na stop, Excel (ili Word)  
  pamti  svaku radnju korisnika. 
 
8. Pažljivo (ne treba žuriti) izvedemo slijed radnji koje želimo 

automatizirati. U EXCEL-u mogu e su dvije opcije premještanja u 
ciljane elije prilikom snimanja. Jedna definira apsolutne, a druga 
relativne adrese. Relativa opcija zna i, da e se kursor pomaknuti za 
onoliko elija horizontalno i vertikalno, za koliko smo ga pomaknuli 
za vrijeme snimanja, bez obzira gdje se trenutno nalazi na EXCEL-
ovoj matrici. Apslutna opcija za razliku od toga postavlja kursor 
to no u onu eliju u koju je postavljen prilikom snimanja. Jedna 
opcija se mijenja u drugu, ako kliknemo na mali šareni kvadrati  uz 
stop-dugme za prekid snimanja. Nakon snimanja macroa, klik na 
stop-dugme prekida snimanje.  

   Dugme stop nestaje sa ekrana. 
9. Odmah isprobamo makro pritiskom na definiranu  
 kombinaciju tipki ili slijedom naredbi: 
  Prikazuje se panel s postoje im 

Tools > Macro > Macros  makroima. 
  

10. Klikom ozna imo odabrani makro i SPREMITE FAIL NAKON SNIMANJA 
 aktiviramo ga klikom na Run 

  
Gotov makro možemo mijenjati samo izmjenama u programskom kodu, ili ga moramo brisati 
i snimati ponovo. Novo snimanje na postoje e ime ne e promijeniti postoje i makro. 

 
Kod u itavanja dokumenata koji sadrže makro, Word ili Excel sa srednjom razinom zaštite pitat 
e Vas želite li ga aktivirati ili deaktivirati. Deaktiviranjem makroa, smanjuje se opasnost od 

aktiviranja virusa u nepoznatim datotekama. Razumije se, macro koji smo sami snimili moramo 
aktivirati ako želimo da funkcionira prilikom korištenja datoteke. 
 

Dugme za pokretanje makro-a 
 

ISPIŠI
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Makro snimljen na opisani na in možemo pokrenuti kombinacijom definiranih "vu ih tipki" (koje 
ete zaboraviti do prve slijede e uporabe) ili slijedom komandi Tools > Macro > Macros, izborom 

makroa sa liste i klikom na Run, što je esto kompliciranije nego izvo enje željene radnje bez 
makroa. Zbog toga je dobro prilikom snimanja kreirati naredbu za alatnu traku, (klikom na 
ikonu s eki em) s koje se makro može pokrenuti jednim klikom. 

 
Druga mogu nost je kreiranje ekranskog dugmeta za pokretanje makroa. Postupak je 

slijede i: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  

 
 
Napomena:  U višekorisni kim aplikacijama može se javiti problem nepoznatog nivoa zaštite 
kod nekih korisnika, koji možda nisu upoznati sa pri om oko sigurnosti. Ako naime u datoteci 
koristimo izborne opcije  s kruži ima         ili kva icama      , OFFICE u datoteku automatski 
unosi macro-e koji se ne vide u popisu macros (makro naredbe) s opisanim utjecajem na 
sigurnosni režim, tj. OFFICE e odbiti u itavanje datoteke ako je sigurnost postavljena visoko.  

ak i ako uklonimo sve macro-e i navedene izborne opcije iz datoteke, OFFICE-ova 
sigurnost e se ipak ponašati kao da datoteka još uvijek ima macro-e, što je prili no idiotska 
opcija, jer ako smo jednom unijeli samo jedan macro ili izbornu opciju u datoteku, nemogu e 
je potpuno vra anje datoteke (npr. kreiranog obrasca) u stanje bez macro-a. Možete jedino 
brisati datoteku i kreirati sve ispo etka, ovaj puta bez macro-a i izbornih opcija.  
 
EXCEL   IZBORNA ELIJA U EXCEL TABELI  (Combo-Box) 

 

1. Klik na prazni dio (sive) podloge za 
alatne trake na vrhu ekrana 
 

2. Biramo Command Tool-Box 
(Alatni okvir kontrola) 
 

3. Kliknemo na mjesto gdje želimo 
komandno dugme 
 

4. Biramo Command Button 
(Naredbeni gumb)  

 
 
5. klik na sli icu Propertis (svojstva) 
 
6. U eliju Caption upisujemo tekst 

koji želimo na dugmetu 
 

7. Desni Klik na novo dugme otvara 
menu s opcijom View Code 
(Pogledaj kôd) 

 
8. U retku izme u prvog i zadnjeg 

upišemo ime  ve  snimljenog 
makroa i izlazimo iz editora 
makroa 
 

9. Klik na sli icu za izlaz iz dizajn-
moda u alatnoj traci kontrola (ili 
malom okviri u koji se možda 
otvorio upravo za tu namjenu) 
 

10. Zatvaramo alatni okvir kontrola i 
spremamo dokument sa kreiranim 
dugmetom. 

               djelovanje: 
 
otvara se lista alatnih traka 
 
 
otvara se alatna Alatni okvir kontrola  
 
 
kursor ostaje na tom mjestu 
 
na mjestu kursora ubacuje se dugme u
režimu za podešavanje opcija. Možemo 
ga postaviti iza teksta zbog preciznijeg 
pozicioniranja. 
 
otvara se okviri  svojstava 
 
tekst CmmandButton 1 mijenja se u 
upisani tekst. Zatvaramo propertis. 
 
Prvi i zadnji red programskog koda je 
ve  upisan, izme u je kursor u 
praznom retku 
 
 
Izmijenjeni kôd automatski se pamti 
 
 
 
Prekida se postupak kreiranja dugmeta 
i dugme poprima funkciju. 
Ako ga kliknemo, makro e se izvršiti. 
 

propertis 
(svojstva) 
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Kombinirana izborna elija (Combo-Box) 
služi za manuelni izbor proizvoljnog podat-
ka iz proizvoljne kolone neke tabele (koja 
može biti i sakrivena), sa izbornika (menu-
a) koga otvara klik na trokuti  uz izbornu 
eliju. U našem primjeru izbor imena grada 

sa menua izborne elije, unijet e 
poštanski broj grada iz tabele (koja je 
korisniku sakrivena) u odredišnu eliju C2 
 
POSTUPAK:   crtanje izborne elije        pebacivanje dizajn-mod  -  radni režim     
 

1. desni klik na praznom dijelu sive otvara se popis traka s alatima  
 menu-trake na vrhu ekrana    
   Otvara se traka s izborom kontrola 
2. biramo Control Toolbox   u dizajn modu za kreiranje kontrola  
                                         
3. klik na Combo_box kursor se mijenja u križi , a Excel

 prelazi u tzv. dizajn mod u kome se
 kontrole izra uju, a ne funkcioniraju.
 Trokut s ravnalom  ozna en bijelom  

4. S križi em kursora  crtamo strelicom gore-lijevo na Control-Toolbox-u  
 kombo- eliju bilo gdje na ekranu utisnut je (ako nije, kliknimo ga lijevom  

 mišjom tipkom !) 
 

prilagodba parametara 
 

5. desni klik na combo_box (nacrtanu eliju)  i izbor opcije  
Properties (svojstva) iz menua (izbornika) otvara lijevo prikazan 
okvir. Od mnogih opcija ovog propertisa važne su samo tri - etiri: 
Na vrhu okvira Propertis pod Name unesemo ime izborne elije 
(možemo ostaviti i ComboBox1, ali se takva imena teško razlikuju) 

 
6. BoundColumn  upisujemo broj kolone izvorne tabele u kojoj 

su ciljane vrijednosti (kod nas je to poštanski broj u koloni 2) 
 

7. Linked Cell  je elija u koju e se upisati odabrani 
element. U našem poštanski broj upisivat e se u eliju C2.  

 
8. ListFillRange  unosimo pravokutno podru je podataka 

tabele sa vrijednostima u obliku E2:F6  ili možemo unijeti ime 
podru ja ako smo ga prethodno imenovali   

 
9. u Column Count upiši željeni broj vidljivih kolona u listi 

(padaju em izborniku) koju otvara kombinirana elija, a u 
ColumnWidth upiši širine kolona (od lijeve prema desnoj) u 
pikselima odvojene zarezom. 

 
10. Time smo završili najvažnije. Klikom na sli icu trokuta na Control 

Toolbox markici deaktiviramo dizajn mod, i od tog trenutka naša 
kombinirana elija bi trebala raditi. Kad kliknemo na mali trokuti  
na njenom desnom rubu, otvara se lista (padaju i izbornik) iz koje 
biramo željeno ime grada. U eliju C2 ( Linked Cell ) automatski e 
se upisati poštanski broj odabranog grada i ako ne vidimo tabelu. 

 
 Ostali parametri služe uglavnom za "šminkanje" (vrsta, debljina i  
 boja slova, okvira i pozadine elije, prikaz zaglavlja u padaju em 
 izborniku-u i dr.).  
 
 
 

EXCEL        KREIRANJE LOOKUP-FUNKCIJE 
 

 
 

 

 

 

2

C2 

E2:F5 
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Combo-Box izborna elija je vrlo prikladna za manualni izbor zahtijevanog elementa 
zadane tabele. Ako je me utim odabir referentnog podatka rezultat Excel-ove rekalkulacije ili 
možda izvo enja makroa, kombinirana izborna elija je neupotrebljiva. 

Za takav slu aj EXCEL predvi a korištenje  LOOKUP funkcije. Ona omogu uje vertikalno 
(VLOOKUP) ili horizontalno (HLOOKUP) pretraživanje zadane tabele (Table Array) po 
referentnoj koloni sli no Combo-Box eliji. Razlika je u tome, što se zadani podatak (Lookup 
Value) ne bira iz izbornika, nego se upisuje (ili može biti rezultat automatske obrade) u 
odabranu eliju. Ako eliju u kojoj se automatski ispisuje neki me urezultat odaberemo kao 
eliju za Lookup-Value u primijeni Lookup funkcije, u odabranoj odredišnoj eliji automatski e 

se unijeti odgovaraju i podatak iz proizvoljne tabele koja može biti skrivena.  
Ovo je zvu alo strašno komplicirano, ali na primjeru emo vidjeti da je stvar zapravo vrlo 

jednostavna.   
 
Primjer:  Ako se u eliji B3 pojavi jedno od imena osoba iz prve kolone tabele  T2, 

želimo u odredišnoj eliji  B5   dobiti starost te osobe. Tabela koja prikazuje imena i starosti 
osoba nalazi se izvan vidljivog podru ja (može se po potrebi i sakriti, primjerice sakrivanjem 
kolona u kojima je tabela smještena). Tabela može biti smještena i na drugom listu  (sheet-u) 
radne knjige, tj. faila na kome radimo. Kreirajmo dakle Lookup funkciju s odredišnom elijom 
B5. 

 
POSTUPAK: 

kreiranje Lookup funkcije 
 
1. utipkaj pomo nu tabelu  (desno u okviru) 
 

A B C D E F 

                                    

         Tabela   T2
ime: marko ime starost

pero 45
starost: 12 marko 12

jure 32
ive 16

 
 
2. Primjeni funkciju  VLOOKUP  iz grupe  Lookup & Reference na slijede i na in: 
 

Na EXCEL-ovoj traci s alatima klik na ƒx      otvara okvir za izbor funkcija (na slici)  
lijevo biramo grupu Lookup & Reference  desno se otvara se popis tih funkcija,

  
 
 
 
 
 
 
 
 

biramo funkciju VLOOCUP 
(vertikalno pretraživanje tabele) otvara se panel na slici

 
 
 
 
 

 
biramo funkciju  VLOOKUP otvara se slijede i " arobnjak" za unos  

 

 
1 
2 
3 
4 
5 
6 
7 
8 
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u Lookup_value  (zadana vrijednost za pretraživanje) unosimo adresu  elije u kojoj 
ekujemo (ili emo upisivati) ime osobe ija nas starost zanima.  U našem slu aju to 

je (B3). Uokvirimo je da ne zaboravimo gdje se nalazi i ispred nje upišimo rije  "ime:") 
 
Na desnom kraju elije Table_array (podru je tabele) gornjeg panela za unos, klik na 
šareni pravokutnik omogu uje nam da kursorom odredimo podru je podataka u ciljanoj 
tabeli (bez zaglavlja). Umjesto toga možemo i upisati podru je od lijevog gornjeg do 
desnog donjeg ugla tabeliranih podataka u obliku F3:G7, kao na slici. 

 
u Col_index_num  upisujemo broj kolone u kojoj se nalazi ciljani podatak. Pri tome 
prva kolona lijevo je kolona broj 1.  U našem slu aju, starost osoba je u koloni  2. 

 
u Range_Lookup  upisujemo  FALSE  ako se u eliji imena  (B3)  treba na i doslovna 
vrijednost iz prve kolone,  a TRUE  ako to može biti najbliža vrijednost onoj koja je 
utipkana kao Lookup Value (zadana vrijednost). U našem slu aju u eliji imena treba se 
na i doslovna (znakovna) vrijednost jednog od imena u prvoj koloni tabele, pa 
upisujemo  FALSE  (u ve ini slu ajeva to e biti ispravan izbor). 

 
im smo upisali FALSE, na dnu panela za pomo  pojavljuje se rezultat formule, odnosno 

starost prve osobe u tabeli. Klik na  OK  zatvara pomo ni panel i stavlja VLOOCKUP u funkciju  
 
Sad ve  VLOOKUP funkcija funkcionira, tj. ako u eliju imena utipkamo  "Marko", u eliji 

starosti pojavit e se Markova starost, tj. broj 12. Ako je u eliji zadane vrijednosti B3 formula, 
vrijednost, odnosno ime osobe e u eliju postavljati EXCEL kao rezultat rekalkulacije odnosno 
obrade, a starost osobe upisat e se u odredišnu eliju posve automatski bez naše intervencije. 
  

Prikazana VLOKUP funkcija vertikalno pretražuje zadanu tabelu. Jednako se koristi 
funkcija HLOKUP, koja referentne podatke umjesto iz prve kolone, uzima iz prvog retka.  

 
Uz pomo  Combo-Box-a i Lookup funkcija, te makro-a i u EXCEL-u se mogu 

automatizirati i relativno složene obrade s primjenom razli itih poreznih stopa zavisno o 
ulaznim podacima, razli itih vrsta ugovora, s automatskim popunjavanjem virmana s razli itim 
pozivima na broj i dr. Dakako, mogu e su mnoge druge najrazli itije primjene, koje uporabu 
EXCEL - aplikacije svode unos ulaznih podataka. Sve ostalo, EXCEL e obaviti automatski. 
Ipak, treba re i da kreiranje složenijih aplikacija zahtijeva prili nu dozu dovitljivosti i mnoge 
sate prakti nih pokušaja. No lijepo složena aplikacija, omogu it e Vam da se bavite 
problemom koga obra ujete, umjesto da se iscrpljujete sa samom obradom. Zato, vrijedi 
uložiti trud u upoznavanje opisanih opcija. Po nite s jednostavnim primjerima. 
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  iPC - PONUDA GOTOVIH APLIKACIJA 

  
Koriste i napredne mogu nosti EXCEL-a ili ACCES-a, iPC - INOVACIJSKO-

PODUZETNI KI CENTAR Rijeka, razvio je brojne aplikacije na hrvatskom jeziku koje se 
odlikuju maksimalno mogu om automatizacijom, te  jednostavnim i logi ki osmišljenim 
rukovanjem. Po dogovoru, mogu se izvesti i preinake, ili izraditi aplikacije po Vašim 
potrebama. Ne žalite platiti vrijednost jedne, dviju  šteka cigareta za aplikaciju koja e Vam 
zna ajno olakšati život i mu no administriranje pretvoriti u zadovoljstvo. Evo nekih naslova: 

 
 

MEMBERS lanska evidencija u dvije verzije (za udruge i za Saveze i Zajednice). Prikladna 
je i za sportske organizacije i politi ke stranke ili evidenciju poslovnih stranaka, 
pacijenata i sl. Automatsko kreiranje imenika, adresiranje pisama s automatskim 
upisom poštanskih brojeva iz uklju ene baze podataka i dr.. 

 
iPC_FKV Financijsko knjigovodstvo namijenjeno korisnicima bez ra unovodstvene 

naobrazbe, omogu uju pra enje bezgotovinskog i blagajni kog poslovanja i 
financijsko pra enje projekata. Idealno za inženjere, poduzetnike, udruge i dr.  

 
iPC_notes Jednostavna evidencija i pra enje izvršenja zadataka s brojnim pomo nim 

rutinama koje se mogu dobaviti i kao samostalni moduli: 
 

Ispis virmana 
obra un putnih naloga 
evidencija i obra un radnih naloga (ili intelektualnog angažmana i sl). 
evidencija režijskih troškova i troškova automobila (za firmu ili obitelj) 
sustav bilješki organiziranih po projektima ili temama (iskoristiv za 
najrazli itije namjene od ozbiljnih projekata do elektronske kuharice ili 
evidencije lijekova, ljekovitog bilja itd.) i drugo. 

 
iPC_štoperica evidencija i obra un radnih naloga u dvije verzije (EXCEL i ACCES) za 

pra enje jednog ili više projekata. Po etak i završetak posla unosi se jednim 
klikom, sve ostalo automatski obavlja aplikacija i na zahtjev ispisuje izvještaj po 
projektima,  radnim nalozima i poslovima koji terete nalog. 

 
iPC_ARHIV Evidencija literature, lanaka, projekata, dokumentacije, posu enih ili zaduženih 

sitnica (klju eva, mobitela, pribora, alata i sl.) Uklju ena iPC_klasifikacija. 
 
iPC_Biro Kompleksna aplikacija u ACCESS-u 2000 koja obuhva a izuzetno detaljnu 

evidenciju osoba (s posjetnicama, osobnim kartama) i subjekata (tvrtki, radnih 
grupa, timova, prijatelja i rodbine i dr.), te projekata svih vrsta, sa svim 
složenim me uovisnostima. Osobe mogu biti autori, ponu i, izlaga i, lanovi 
timova ili udruga itd. itd.  Subjekti se grupiraju u proizvoljne srodne grupacije.   

 Aplikacija prati fizi ku realizaciju projekata (pregled zadataka i izvršenja, 
kronologije važnijih doga aja) sa selektivnim skupnim pregledom svih projekata. 

 Sadržana je evidencija nastupa na sajmovima, osvojenih priznanja i dr, te brojne 
pomo ne rutine. Uklju ena je iPC_klasifikacija  koja u cca 1200 pojmova 
obuhva a sve što se može na i kao predmet interesa u gospodarstvu, upravi, 
projektnim ku ama i dr, a šifriranje se obavlja u desetak sekundi. 

 
Sve aplikacije sadrže brojne ekranske i automatski pripremaju tiskane izvještaje, koji se 
ispisuju na jedan klik bez potrebe bilo kakvog podešavanja, isklju ivo na temelju unosa ulaznih 
podataka. Za korištenje aplikacija dovoljno je elementarno poznavanja rukovanja s ra unalom. 
Na zahtjev dolazimo prezentirati složenije aplikacije ili dostavljamo demo ili trial verziju. 
        

Uspjeh u radu želi Vam  iPC - Rijeka 
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